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Preface

Information on the SINAMICS S120 documentation
The SINAMICS S120 documentation is divided into the following areas:

¢ General documentation/catalogs

¢ Manufacturer/service documentation

¢ Electronic documentation

Table 1-1 Usage phases and the available documents/tools

Usage phase

Document/tool

Exploratory

Sales documents for SINAMICS S120

Planning/configuration

SIZER configuration tool

Decision/ordering

SINAMICS S120 catalog

Installation/assembly

SINAMICS S120 Equipment Manuals

Control units and additional system components
Booksize power sections
Chassis power sections

Commissioning

STARTER parameterization and commissioning tool
Getting Started: SINAMICS S120

SINAMICS S120 Installation and Start-Up Manual
SINAMICS S List Manual

Usage/operation

SINAMICS S120 Installation and Start-Up Manual
SINAMICS S List Manual

Maintenance/servicing

SINAMICS S120 Installation and Start-Up Manual
SINAMICS S List Manual

This documentation is part of the technical customer documentation for
SINAMICS. All documents can be obtained separately.

You can obtain detailed information about the documents named in the documen-
tation overview and other documents available for SINAMICS from your local

Siemens office.

In the interests of clarity, this documentation does not contain all the detailed infor-
mation for all product types and cannot take into account every possible aspect of
installation, operation, or maintenance.

© Siemens AG, 2005. All rights reserved

SINAMICS S120 Getting Started with the STARTER Commissioning Tool — 06/2005 Edition




Preface

The contents of this documentation are not part of an earlier or existing agreement,
a promise, or a legal agreement, nor do they change this. Siemens is obliged to
fulfill all requirements specified in the applicable sales contract, which also contains
all the valid terms of warranty. These contractual warranty provisions are neither
extended nor curbed as a result of the statements made in this documentation.

Audience

This documentation is intended for machine manufacturers, commissioning
engineers, and service personnel who use the SINAMICS S drive system.

Objective

Note

“SINAMICS S120 Getting Started with the STARTER Commissioning Tool”
provides an example illustrating how to commission a SINAMICS S120 drive
line-up.

Detailed instructions on commissioning the entire SINAMICS S120 drive line-up
are available in the SINAMICS S120 Installation and Start-Up Manual.

The individual chapters provide information on the following:
¢ Drive concept

e Prerequisites

¢ Creating the drive project OFFLINE

¢ Using the STARTER control panel (motor rotates)

¢ Creating the drive project ONLINE

Finding your way around

To help you find your way around this documentation, the following are provided in
addition to the contents:

1. References (abridged)
2. Glossary (abridged)

3. Index

. © Siemens AG, 2004. All rights reserved
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Danger and warning symbols — explanations

The following danger and warning notices are used in this document:

Danger

This symbol indicates that death, severe personal injury, or substantial property
damage will result if proper precautions are not taken.

Warning

This symbol indicates that death, severe personal injury, or substantial property
damage may result if proper precautions are not taken.

Caution

This symbol indicates that minor personal injury or property damage may result if
proper precautions are not taken.

Caution

(Without a warning triangle) indicates that material damage can result if proper
precautions are not taken.

Notice

Indicates that an unwanted result or situation may result if the appropriate advice
is not taken into account.

Note

This symbol always appears in this documentation where further, explanatory
information is provided.

© Siemens AG, 2005. All rights reserved .
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Definition: qualified personnel

For the purpose of this documentation and the product warning labels, a “qualified
person” is someone who is familiar with the installation, mounting, start-up, opera-
tion, and maintenance of the product. He or she must have the following qualifica-
tions:

e Training and instruction, i.e. authority to switch on and off, to earth and to label
circuits and equipment according to safety regulations.

e Trained in the proper care and use of protective equipment in accordance with
established safety procedures.

e First aid training.

© Siemens AG, 2004. All rights reserved
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Technical notes

Technical support

If you have any further questions, please call our hotline:

A&D Technical Supports Tel.: +49 (0) 180 5050 — 222
Fax: +49 (0) 180 5050 — 223
http://www.siemens.de/automation/supportreques

Please send any questions about the documentation (suggestions for improve-
ment, corrections, and so on) to the following fax number or email address:

Fax: +49 (0) 9131 98 — 63315
Fax form: see feedback page at the end of this documentation
email: motioncontrol.docu@siemens.com

Internet address

Up-to-date information about our products can be found on the Internet at the
following address:

http://www.siemens.com/automation/drives

Trademarks

IBM® is a registered trademark of the International Business Corporation.
MS-DOS® and WINDOWS® are registered trademarks of the Microsoft
Corporation.

© Siemens AG, 2005. All rights reserved .
SINAMICS S120 Getting Started with the STARTER Commissioning Tool — 06/2005 Edition IX
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Preface

ESD notices

/N

Caution

An electrostatic-sensitive device (ESD) is an individual component, integrated
circuit, or module that can be damaged by electrostatic fields or discharges.
Instructions for handling ESD:

¢ When handling electronic components, you must ensure that the person
carrying out the work, the work place, and packaging are properly grounded.

e Personnel in ESD areas with conductive flooring may only handle electronic
components if:

— They are grounded with an ESD wrist band
— They are wearing ESD shoes or ESD shoe grounding straps

¢ Electronic boards should only be touched if absolutely necessary. They must
only be handled on the front panel or, in the case of printed circuit boards, at
the edge.

¢ Electronic boards must not come into contact with plastics or items of clothing
containing synthetic fibers.

e Boards must only be placed on conductive surfaces (work surfaces with ESD
surface, conductive ESD foam, ESD packing bag, ESD transport container).
¢ Electronic modules must be kept at a distance from data display equipment,
monitors, and televisions (minimum distance from screen: >10 cm).
¢ Measurements must only be taken on boards when:
— The measuring device is grounded (with a protective conductor, for
example).
— The measuring head has been temporarily discharged before

measurements are taken on a floating measuring device (e.g. touching a
bare metal controller housing).

© Siemens AG, 2004. All rights reserved
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Safety information

/N

Danger

The device must not be commissioned until you have ensured that the machin
in which the components described here are to be installed complies with the
98/37/EU Directive.

SINAMICS devices and AC motors must only be commissioned by suitably
qualified personnel.

Personnel must take into account the information provided in the technical
customer documentation for the product, and be familiar with and observe the
specified danger and warning notices.

Hazardous voltages are present in electrical equipment and motors during
operation.

Dangerous axial movements can occur in the system during operation.

All work on the electrical system must be carried out when the system has
been disconnected from the power supply.

SINAMICS devices with AC motors must only be connected to the power
supply via an AC-DC residual-current-operated device with selective switching
once verification has been provided that the SINAMICS device is compatible
with the residual-current-operated device in accordance with EN 50178,
Subsection 5.2.11.2.

e

Warning

The successful and safe operation of these devices and motors depends on
correct transport, proper storage and installation, as well as careful operation
and maintenance.

The specifications in the catalogs and offers also apply to special variants of
the devices and motors.

In addition to the danger and warning information provided in the technical
customer documentation, the applicable national, local, and system-specific
regulations and requirements must be taken into account.

Only protective extra-low voltages (PELVs) that comply with EN60204—1 must
be connected to all connections and terminals between 0 and 48 V.

© Siemens AG, 2005. All rights reserved
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/N

Xii

Caution

The surface temperature of the motors can reach over +80°C.

For this reason, temperature-sensitive parts (lines or electronic components,
for example) must not be placed on or attached to the motor.

When attaching the connecting cables, you must ensure that:
— They are not damaged

— They are not under tension

— They cannot come into contact with rotating parts

Caution

As part of routine tests, SINAMICS devices with AC motors undergo a voltage
test in accordance with EN 50178. Before the voltage test is performed on the
electrical equipment of industrial machines to EN 60204—1, Section 19.4, all
connectors of SINAMICS equipment must be disconnected/unplugged to
prevent the equipment from being damaged.

Motors must be connected in accordance with the circuit diagram provided.
They must not be connected directly to the three-phase supply because this
will damage them.

Note

When operated in dry operating areas, SINAMICS equipment with three-phase
motors conforms to low-voltage Directive 73/23/EEC.

© Siemens AG, 2004. All rights reserved
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Drive Concept 1

This “Getting Started” manual uses simple examples to describe how a standard
drive application is configured.

The standard application uses a minimum SINAMICS S120 configuration.

Commissioning is carried out using the STARTER commissioning tool.

This chapter provides an introduction to the SINAMICS drive concept.

Note

A detailed description of the drive system is available in the Installation and
Start-Up Manual /IH1/ and Equipment Manuals /GH1/ and /GH2/ (see References
in the appendix).

© Siemens AG, 2005. All rights reserved
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Drive Concept

1.1 Components

SINAMICS is a modular system that enables you to build your drive.
The key components of the SINAMICS modular system are:
e Control Unit

¢ Active Line Module (infeed)

e Motor Module (power section)
e Sensor Module

e Terminal Module

Fig. 1-1 shows the key drive components (the required 24 V DC power supply, line
filters, line reactors, line contactors, and power cables are not shown):

‘I/ DRIVE-CLiQ

Terminal Module
/ s

Sensor Module

7
Control Unit /

Active Line Module

Motor Module

Fig. 1-1 Standard components of the SINAMICS modular system

Interface (component connection)

The central Control Unit communicates with the intelligent, peripheral drive compo-
nents (Motor Modules, Terminal Modules, and Sensor Modules) via a standard dig-
ital interface (DRIVE-CLIQ).

The physical arrangement of the connections between the Control Unit and periph-
eral drive components is known as the DRIVE-CLIQ topology.

© Siemens AG, 2004. All rights reserved
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Drive Concept

1.2 Control Unit

The Control Unit is responsible for all closed-loop/open-loop and communication
functions with the drive system components.

The following functions are available:
¢ Closed-loop control of the Active Line Module (infeed)

¢ Closed-loop control for the drive (comprising the motor, Motor Module, speed
sensor/position encoder, and Sensor Module)

e Communication with a higher-level controller

¢ Communication with the commissioning system (STARTER)
e Evaluation of the inputs/outputs on the Control Unit

e Evaluation of the optional Terminal Modules

e Evaluation of an option board plugged into the Control Unit

© Siemens AG, 2005. All rights reserved
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Prerequisites 2

This chapter describes the prerequisites for step-by-step configuration and com-
missioning.

The configuration and commissioning steps are described in detail in Chapters 3
and 5.

2.1 Hardware and software components

In our example, a drive unit is to be assembled for a motor.

The following components are required for the drive unit:

¢ Active Line Module

¢ Control Unit CU320

¢ Motor Module

e Sensor Module SMC20

e Synchronous motor (e.g. 1FK6) or induction motor (e.g. 1PH7) with sensor
e DRIVE-CLIQ cables

You will also need line filters, line reactors for the Active Line Module, motor,
power, and encoder cables, as well as a SITOP modular 24 V DC power supply,
for example.

The following prerequisites must be fulfilled before you start commissioning:
¢ The CompactFlash Card with firmware must be inserted.
¢ The components are wired by means of DRIVE-CLiQ

« The PROFIBUS interface Control Unit is connected to a PC/PG via a
PROFIBUS interface

e The STARTER commissioning tool must be installed on your PC/PG

Note

For instructions on wiring the components, connecting the PROFIBUS interface to
a PC/PG, and installing the STARTER commissioning tool, see the Equipment
Manuals /GH1/ and /GH2/ and the Installation and Start-Up Manual /IH1/.

© Siemens AG, 2005. All rights reserved
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Prerequisites

2.2 Wiring the components

Fig. 2-1 shows how the components can be arranged and interconnected for the
sample project. The DRIVE-CLIQ wiring is highlighted in bold.

L2
L3
Q1
TR VA S
24V ISITOP!
external ‘
):%SBVAWA : Qi
13 ' 14
—o
DRIVE-CLIQ
[ 1 [ [ FITTh
100X101 X200 34 [X200 x203 34
EP EP
Control —
unit
320
2 Active Line Single Motor
Module Module X500
[I F1-
Hx124 1| xs20
: Sensor
H1 po ! | Moduie
v | smc20
S :
= g
= =
i
_N\e-N\o-- H 1
N--N-3¢ Line contactor @ @ !
L = H
- - |
!
1
i
4// \
i
Line filter i
_________________ 4
i
Line reactor H
= (i) 1FK6 or 1PH7
PROFIBUS

EDE $PC/PG

Fig. 2-1 Component wiring (example)

© Siemens AG, 2004. All rights reserved
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Prerequisites

2.2.1 Assembling the drive unit

The components must be assembled in accordance with the specifications in the
Equipment Manuals /GH1/ and /GH2/ and the DRIVE-CLIiQ wiring guidelines in the
Installation and Start-Up Manual /IH1/.

Note

The installation and wiring procedures are described in the Chapter “Cabinet
configuration and EMC booksize” in the Equipment Manual.

DRIVE-CLiQ

To assemble the drive unit components, wire the DRIVE-CLIiQ cables as follows
(see also Fig. 2-1):

1. Start by connecting DRIVE-CLiQ socket X100 on the CU320 to DRIVE-CLIQ
socket X200 on the Active Line Module.

2. Connect X101 on the Control Unit to X200 on the Motor Module.

3. Connect encoder evaluator X500 on the Sensor Module to the associated Motor
Module using DRIVE-CLiQ socket X202.

PROFIBUS address

4. A PROFIBUS switch that you can use to set the PROFIBUS address for the
drive unit is located behind the lower, petrol-green removable cover on the
CU320. Set the PROFIBUS address (e.g. 5 (S1 + S3 = ON)).

Fig. 2-2 shows the significance of the PROFIBUS switch.

20 21 22 23 p4 25 26
1 2 4 8 16 32 64

ON
R oFF
s7

S

xample [ [ | | | fon
BEN
1+ 4 =5
Fig. 2-2 Example: setting the PROFIBUS via the PROFIBUS switch on the Control Unit

Significance

CompactFlash card

5. Insert the CompactFlash card with SINAMICS S120 firmware into the Control
Unit CU320.

24 V power supply
6. Switch on the 24 V power supply.
PC/PG PROFIBUS interface

7. Use a PROFIBUS cable to connect the PC/PG to the CU320 via the PROFI-
BUS interface.

© Siemens AG, 2005. All rights reserved
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Prerequisites

2.3 The STARTER commissioning tool

To start the STARTER application, click the STARTER icon or choose the following
menu path in the Windows start menu: Start > SIMATIC > STEP 7 > STARTER.

Note

The screenshots used in this manual are from STARTER version V3.2. Screens in
other versions may differ slightly from those used here.

2.3.1 The STARTER user interface

You can use STARTER (see Fig. 2-3 on the following page) to create the sample
project. The different areas of the user interface are used for different configuration
tasks:

¢ Project navigator: this area displays the elements and objects that can be
added to your project.

¢ Working area: You create the project in this area:

— When you are configuring the drive, this area contains the Wizards that help
you configure the drive objects.

— You can configure the parameters for the speed setpoint filter, for example.

— When you call up the expert list, the system displays a list of all the parame-
ters that you can view or change.

¢ Detail view: this area contains detailed information on faults and alarms, for ex-
ample.

© Siemens AG, 2004. All rights reserved
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[ STARTER - Project 2 - [Drive_1 - Speed contraller] _|8l x|
] Project Target system View Optio indows_Help . =)

| D|S(E] & b [wle] =

i =] |=lafF = Project navigator: displays the elements
'—E;J/ and objects for the STARTER project.

B Project_2
) Insert single drive - =
3 flp SIMAMICS_CU3z0 e
e B Overview Adaption
> Configuration P gain [0300 7 Mnsirad ——
> Topolagy Reference model
B Contral Uit forr =] e —
- supply_1
B1-{_{ Input/output companent i P 0000 Nmesrad
1| Drives
®] Insert drive C00 e (=)
=1 f Drive_t A 5
> Drve nvigetor Working area:
» Configuration J
> Contrallagic ) ° i i 1 i
e Dlsplgys the_ Wizard for configuring
> setpant sditcn the drive objects.
> Speed setpoint Filter
e Y * Displays the parameters for the
> Torque setpoints H ]
g ffeeen speed setpoint filter, for example.
» Current setpoint filker
» Current controller =
> Power unit
i > Motor LI
> Motar encader
-3 Functions lj 5.5 | elp
: 2 Detail view: Displ ific inf ti
ey ~FEl etail view: Displays specific information
B (faults, for example). =
Level | Message ||
Ermor Ermor occurmed whils converting the projsct
Errar Ermar an: Convert projsct
Errar Farmat armar [ret = 0xhe17007d)
[ Convet |
Press F1 to open Help display. offline mode | I

Fig. 2-3 The different areas of the STARTER user interface
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23.2

2-24

Principle of the STARTER commissioning tool for
SINAMICS S120

When you create a drive unit for a SINAMICS S120 system, the following prin-

ciples apply:

The tool is used to configure objects (e.g. infeed). The object name is user de-

fined.

In STARTER, a drive unit always comprises a Control Unit and the associated

drives.

With a controlled infeed, the Active Line Module is configured in STARTER. An
uncontrolled infeed is not configured in STARTER.

The drive comprises a Motor Module (power section) and a motor with an encoder.

Fig. 2-4 shows the STARTER project navigator. You can see that a project
(Project_Philosophy) and a drive unit (Drive_Unit_One_Motor) have been

configured for a drive.
] Project Targetsystem Wiew Options Window Help 1@ x|

| Di=a| =] 5|8y o] x| =% || |
I Y e T e = T

E-EP Froject 2
) Insert single drive
= fllp saMICS_Cuszo

> Overview
> Configuration
PR Toroiogy

[ Control_Unit

- supply_t

B4 Inputfoutput companent

14 Drives

ELT

| 2] a1

Topology es |

Topology Project set Set etz | [Veraleich -

Contral_Unit (1)

e

=] Supply_1 (2)

= [THIR Prive

Free
Free
1.Fower_unit (3)

; F
B Insert drive: s
- Drive_1 O[T Drive_1,5MC10_to_Motor (5)
Free
Free
o Free
Component depot I=|
= = |
Filter: |DRIVE CLIQ + Option Slot =
Update topology Close Help
Pioject f Dive 1 SINAMICS Cu3z0 |
x
Level | Message
L] 3]
] Convert 5] Topology output |
Press F1 to open Help display. Offline mode

Fig. 2-4 Drive unit with one motor
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If you then want to create a drive unit for two motors, the drive unit will still com-
prise one Control Unit and one Active Line Module (infeed), but this time will in-
clude two drives.

Fig. 2-5 shows the STARTER project navigator. A second drive unit unit with the
name Drive_Unit_Two_Motors, which is designed for two drives, has been con-
figured in the same project (Project_Philosophy).

[ STARTER - Project_2 - [SINAMICS_5120 - Tapology] — = x]
] Project Targetsystem Wiew Options Window Help 1@ x|

| Dja{=]| S| 5 F| @] =[] w2 | =5 || 2| 5|
I e e o O e = S S M A T

=8P Project_2 Tapology Project set Set etz | [Veraleich -

) Insert sinale drive

Topology ies
= flls siamMICS_Cuszo LR |
> Overview Control_Unit (1)
Configurat
St = oy 2 2)
[ Contral_Unik Free
- suppy_1 ; Free
1 4 Inputfoutput component = [TLITHR Drive_2.Fower_unit (3)
B Drives
H o Free
= fils saMICS 5120
S Gvervio : : o[ Drive_2.3MC10_to_Motor (S)
> Corfiguration Free
PR Toroiogy e
B Contral_Unit l-
i Free
- supply_2
B4 Inputfoutput companent
{1 Drives
B Insert drive
-] Drive_2
B)  Comporent depot =]
| B ' E
Filter: [DRIVE CLiQ + Option Slot
Update topolony Coee | Hep |
Project £ Drive_1 | £ SINAMICS_CU320 gy SINAMICS 5120
*
Level | Message
1 0]
B Convert. 5 Topology output
Press F1 to open Help display. Offline mode T i

Fig. 2-5 Drive unit with two motors
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2.4

241

2-26

Commissioning

Once you have carried out the steps described in Sections 2.1 to 2.3 (DRIVE-CLIQ
wiring, connecting the Control Unit to a PC/PG via PROFIBUS, STARTER on
PC/PG), you can start commissioning using the example provided.

STARTER offers two alternative methods for creating a drive project:
¢ OFFLINE: you use a Wizard to configure and parameterize the drive unit.

e ONLINE: you use a Wizard to load the existing drive unit configuration and
parameterization to STARTER.

If you have created or loaded a project in STARTER, you can operate the drive via
the STARTER control panel.

Subsections 2.4.1 to 2.4.3 contain tables listing the main commissioning steps for
this example. For detailed descriptions, see Chapters 3 to 5.

Creating the drive project OFFLINE
To create the drive project OFFLINE, carry out the following steps:

Table 2-1 OFFLINE

Step Procedure Chapter/
section
1 Start the STARTER commissioning tool and use the 3.1
STARTER project Wizard to create a new project.
Set up the PROFIBUS interface. 3.1
Insert the drive unit. 3.1
Use the Wizard to configure the drive unit with, for 3.2

example, the infeed, drive properties, drive with power
section, motor, encoder, and so on.

Save the project. 3.2
Continue with “Using the STARTER control panel (motor 4
rotates)”.
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24.2 Using the STARTER control panel (motor rotates)

You have to carry out the following steps to use the STARTER control panel and
activate the motor:

Table 2-2 Motor rotates
Step Procedure Chapter/
section
1 Open the project. 4.2
2 Establish a connection to the target system. 4.2
Switch to ONLINE mode.
3 Load the project to the drive unit. When doing so, watch 4.2
the LEDs on the Control Unit. These indicate when the
project has been fully loaded.
4 Save the parameters in the drive unit with RAM to ROM. 4.2
Use the control panel in the STARTER. The motor starts 4.3
to rotate.
243 Creating the drive project ONLINE
To create the drive project ONLINE, carry out the following steps:
Table 2-3 ONLINE
Step Procedure Chapter/
section
1 Start the STARTER commissioning tool. 5.2
2 Create a new project. 5.2
3 Set up the PROFIBUS interface. 5.2
4 Carry out an ONLINE search for the stations (drive units) 5.2
that you can access. The drive unit is inserted in the
project.
5 Configure and enter the drive unit topology and 5.3
configuration automatically.
6 Configure the motor and check the topology that has been 5.4
entered.
Save the project. 5.4
8 Continue with “Using the STARTER control panel (motor 4
rotates)”.
|
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This chapter shows you how to create the sample project in STARTER by carrying
out the following activities OFFLINE:

e Creating a new project
¢ Defining an interface
¢ Inserting a drive unit

e Configuring the drive unit and its components
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3.1 Creating the project

Start by opening a new project for your example:

1. To start the STARTER commissioning tool, click the STARTER icon or choose
the following menu path in the Windows start menu: Start > Simatic > STEP 7
> STARTER.

When the software is started for the first time, the main screen (see Fig. 3-1)
appears with the following windows:

“STARTER Project Wizard”
“STARTER Getting Started Commissioning Drive”

(“FSTARTER - Project_2 _|8]x

Froject  Targstsystem View  Options Window. Help

] L\legl\_nﬂ%@n:lgn_l EEEE]

You can call up the project
Wizard by choosing
Project > New with Wizard.

1 2 3 4
reate FG/PC - Set Insert drives Summary

project interface
Anange drive units
offfine.
Find drive urits
onling,

Open ssisting J

__ pioject [offe)

¥ Display Wizard during start

Cancel

If you deactivate this field,
the project Wizard is not
displayed the next time you
start the STARTER.

E? Starter First Steps

H oo =2 [ & o

Aushlender  Zurick Vorwaits  Aktuslisieren  Drucken  Optionen

It | indi | Sushen] Getting Started Commissioning Drive

Note:

If you no longer want to display this page automatically at the start, select
Options > Settings, go to the Workbench tab and disable the option
Dlsplay Getting Started at start.

1 o Y e A i S ey ey B il b

@ Create/Propstiss
@ Pioiect Mavigator
@ Commsioning Drives

Project

Press F1 to open Help display. ) i i
Fig. 3-1 Main screen of the STARTER parameterization and commissioning tool

Note

If you deactivate the “Display Wizard during start” field, the project Wizard is not
displayed when you next start STARTER.

You can call up the project Wizard by choosing Project > New with Wizard.
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Note

To deactivate the online help for “Getting started”, follow the instructions provided

in Help.

You can call up the online help at any time by choosing “Help —> Getting started”.

STARTER features a detailed online help function.

2. Close the online help and follow the instructions provided by the Project

Wizard STARTER.

3. Choose Arrange drive units offline (see Fig. 3-2).

Project Wizard Starter ¥ il
1. 2 3 4,
Introduction Create PGAPC - Set Inzert drives Summary
new projeck interface
Arrange drive unitz
affline. ..
L)
B ht]
1. Create new project
2. Set up interface
= 3. Insert drive units
L pen exizting
project [offling]....
v Dizplay Wizard during start
Cancel |
Fig. 3-2 Project Wizard Starter
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The Wizard guides you through the procedure for creating a new project.
4. Enter the project name and, if required, a comment (see Fig. 3-3).

Project Wizard Starter . x|
e 2 i 4
Introduction Creata PG/PC - Set Inzert drives Surmary
new project interface

Pleaze enter the project data:

Froject name; IP'Uin_4
Author: ID oku
Carnrment;
Getting Started ;I

[

< Back | Cortinue | Cancel |

Fig. 3-3 Creating a new project

5. Click Continue > to set up a PROFIBUS interface in the PC/PG.

Project Wizard Starter i |
il 2 3 4
Introduction Create FG/PC - Set [nsert drives Summary
e project interface

Specify the onling connection to the drive unit;

@ Set
CPS511(FROFIBUS]

interface:

Change and test... |

< Back | Eontinue%l Cancel |
X

Fig. 3-4 Setting up the interface

6. In this example, you need a PROFIBUS interface in the PC/PG. Choose
Change and test....
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Set PG,/PC Interface i

Access Path |

Access Point of the Application:

|S?DNLINE [STEF 7]
[Standard for STER 7]

Interface Parameter Azsignment Used:
|CP551‘I[PHEIFIBUS]

BRI CPES1 1ALt

EBICPSS1 1P

EBICPSS11(PRI
CFE511[PROFIBUS - DP Slave]
EZICPRS11[PROFIELS) LI
[Parameter azzignment of your

communications processor CP5511 for a
FROFIBUS netwark]

~» CPES11(PROFIBUS]

=l

Froperties. ..

;I Diagnostics... |

Copy... |
Delste |

—Interfaces

Add/Remove:

Select... |

Cancel |

Help

Fig. 3-5

Setting up the PG/PC interface: properties

7. The system has determined the available interfaces on your PC (e.g. CP5511
(PROFIBUS)). Choose an interface from the Interface Parameter Assignment
Used selection field and then click Properties.

| Eigenschaften - CP551 1{PROFIBUS) il

| PROFIBUS |

— Stationsbezogen
¥ PG/PC ist sinziger Master am Bus

Adresze: ID _I;
I™ | (berpriife Adesse
Timeaout: 1s 2
— Metzbezogen

Ubertragungsgeschwindigkeit:

126

Huchste Teilnehmeradresse:

Frafil;
Standard

Universell [DP/FMS)
Benutzerdefiniert

|

Busparameter...

— Metzkonfiguration

I™ | Felaende Wetekanfiguration berticksichtioen

I aster: |'I j

Slaves: |U

=

=

oK, Standard |

Abbrechen |

Hile:

L

Fig. 3-6

Properties — CP5511 (PROFIBUS)

8. Enter the following properties in the Properties — CP5511 (PROFIBUS) dialog

box (see Fig. 3-6):

— Click the field PG/PC is the only master on the bus.
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— Station address —> 0

Transmission rate e.g.: 1.5 Mbit/s

Highest station address e.g.: 126
Profile — DP

. Click OK.

Set PG/PC Interface

Access Path |

Access Point of the Application:

|S?DNLINE [STEF 7] -» CPEST1(PROFIBLS) j
[Standard for STER 7]

Interface Parameter Azsignment Used:
|CP551‘I[PHEIFIBUS]

Froperties. ..

| CP5511jAuta) ;I Diagnostics... |
HZ CPS511(MP)
BRCPSS1 1[PPI Copy.. |

EBICPSS11PROFIBUS - DP Slave] [Delte |
EZICPRS11[PROFIELS) LI
[Parameter azzignment of your

communications processor CP5511 for a
FROFIBUS netwark]

Fig. 3-7

—Interfaces
Add/Remove: Select.. |
Cancel | Help |
Setting up the PG/PC interface

10.Click Diagnostics.

You can use the diagnostic functions on the PROFIBUS / MPI Network
Diagnostics tab (see Fig. 3-8) to check whether the communication module

for the PROFIBUS line is ready.
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If the module is ready for operation, the module reads and displays the bus pa-

rameters and version data.

In the second part of the tab (bus nodes), you can generate and display a list of
all the bus nodes in the PROFIBUS line.

SIMATIC NET diagnostics - CP5511(PROFIBT=—

PROFIEUS/AMP Metwork Diagnostics | Hardw3

r StatuzMetwork Diagnostics TeSt button
Test !
Station address: I
Bus parameters
L]

r~ Bus Mode:

01234567 8910111212141516171819
o CrErErrrrrrrrrrrErrr-
P20 ) ol ol ol ) o o ol
WCCCrrrrrrrrrrrrrrrr-
BErrrrrrrrrrrrrrrrrr-
100l ) ol o ot ol ot o o
.7 ol ol el ol ol ol

arrrrrrr Key - -
[™ Station passive
Read | [V Station active
[ Station active ready
ok | Cancel | Help |

Fig. 3-8
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Creating the Drive Project OFFLINE

When the module is ready for operation, the text “OK” appears in the field to the
right of the pushbutton (see Fig. 3-9).

In this case, the station address is displayed along with the additional current
bus parameters and version data.

SIMATIC NET diagnostics - CP5511(PROFIBL x|

PROFIEUS /4Pl Network Diagnostics | Hardware
— Status/Metwark Diagnostic:

Test | |UK
Station address: ID

Bus parameters:

Baudrate: 1500.00 Kbps &
Highest station address [HSA): 126

inimum station delay Time [Min Tedi): 11 tBit
M aximum station delay Time [Max Tadr): 150 tBit
Setup time [tzet]: 1 tBit

- Bus Node Empty checkbox

=]
=l

0123456789 1011121314158123=  with 3 light
background

(U1 2 ) O
alfCrrrrrrrrrrrrrrr-
AU ) ol o ) o o o o ) o
U )l ol o
IV )l o ) O
wmrrrrrrrrrrrerrr
2Errrrrr rhees

o)

[7 Stat

QK. D! Cancelnl l Help |

Fig. 3-9 SIMATIC NET diagnostics — CP5511 (PROFIBUS) after the test

Read button

12.To display the stations, click Read.

When the module is ready for operation, the system generates a list of all the
active stations on the bus.

The symbols for indicating the operating mode of the station have the following
meanings:

— An empty checkbox with a gray background (same background color as the
tab page): no partner device found

— Empty checkbox with a light background: passive station (e.g. DP slave)
— Checkmark on a light background: active station (e.g. DP master)

— Checkmark on a gray background: active station ready to be integrated in
the network

Note

This generates considerable load on the bus and may take a few seconds.

13.To complete the process of setting and diagnosing the PC/PG interface, choose
OK, OK and Continue >.
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14.Add the following (see Fig. 3-10):

A new drive unit with the name SINAMICS_CU320
A device: SINAMICS

A type: S120 (6SL3...)

Version V2.3

Bus address (e.g. 5)

Note

The bus address must be the same as the PROFIBUS address set for the Control
Unit (see Fig. 2-2).

Section 3.2 shows you how to configure the drive unit and its components.

To add the components and data listed above, click the relevant selection fields
and then choose Insert.

Project Wizard Starter | |
s 2 H 4
Introduction Create PG/PC - Set Ingert drives Surmmary
new project interface

— Preview — Dirivee: unit
-2 Fraject Device: |Sinamics LI
Type: {5120 ~]
Wersion; vZ2. 3 -
Bus addr.: Im
Narme: |SINAMICS_CU320

Pleaze enter the drive unit data:

Sinamics tutonal I Insert p |
LoV

< Back | Continue > | Cancel |

Fig. 3-10  Inserting the drive unit

Note

To insert other drives in the project, choose Insert.
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The first time you choose Insert, the system displays a tutorial featuring an
introduction to the SINAMICS S120 drive unit (see Fig. 3-11).

& uidemoab

8 [T 1
SIEMENS

SINAMICS S120
Drive Unit

This tutorial gives you a short, self-explanatory
introduction to the SINAMICS S120 Drive Unit

The first step teaches you about the available
components and their installation and wiring
principle.

The second step shows you the interrelation
between SINAMICS $120 components and
the start-up tool STARTER

Click on @ to show the interactive elements

Click on &) to go to the next page.

’{ln,/l

Fig. 3-11  Introduction

15.Work your way through the introduction by choosing >, or exit by choosing X.

Note

To call up this tutorial, choose Sinamics tutorial.
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Once you have inserted the drive unit, the Preview window shows you how the
completed project will appear in the STARTER project navigator (see Fig. 3-12).

Project Wizard Starter |

1. 2. 3 4,
Intraduction Create PGEAPC - Set Ingert drives Summary
hely project interface

Flease enter the drive unit data:

— Previewm — Drive unit
E--% Froject Device: ISinamics ;I
ﬂﬂ SIMAMICS_CU3Z0
Type: {5120 |
Wersion: vZ. 3 -
Bus addr.: 1 *
Mame:; IDrive_unit_D

Sinamics tutanial | Inzert I
< Back | Eontinued Cancel |
1.

Fig. 3-12  Preview: “Project_2”

16.Click Continue >.

Project Wizard Starter ! x|

1. 2 a5 4,
|ntraduction Create PG/PC - Set Inzert drives Summary
new project interface
The following settings have been selected: ;I

- Project name: Project
Storage location: C:hSiemenshStep?hS7proj

- Interface; CPEE11[FROFIBUS]
- Dirive units:

SINAMICS_CU320 [SINAMICS 5120, Addr. 10]

K| ;IJ
< Back | Compleler\l Cancel |

Fig. 3-13  Summary

17.To complete the process of creating a new project for a drive unit, choose
Complete.
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As you can see in Fig. 3-14, the project Wizard has created Project_2, drive
unit SINAMICS_ CU320, and a Control_Unit in the project navigator.

[FTSTARTER - Project_2 .1O] x|

Project Targetsystem View Options Window Help

| Dle|e|| 2] %5 ey o] =] W] |0

| 216 | 881 | a4

£+ Froject 2
) Insert single drive
2 fla SamICs_cuszo
bl
> Overview
> Configuratior
> Topology
[ Contral_Unit

Project
Press F1 to open Help display. Ofiine mode T

Fig. 3-14  STARTER project navigator “Project_2”

Section 3.2 shows you how to configure the components for the drive unit used
in this example.
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3.2 Configuring the drive unit

The following components are required to assemble the drive unit used in this ex-
ample:

¢ Active Line Module

¢ Motor Module

e Synchronous motor (e.g. 1FK6) with sensor (for servo control variant)

¢ Induction motor (e.g. 1PH7) with sensor (for vector control variant)

To assemble the drive unit components, proceed as follows:

1. In the project navigator, open the SINAMICS_CU320 directory and double-click
the element Configure drive unit (see Fig. 3-14).

As you can see in Fig. 3-15, the STARTER opens a Wizard for configuring the
drive unit components.

Configuration - SINAMICS_CU320 - Option module

Are you uzing an option module [option board)?
Cinzert infeed
Cinzert diive
15 ummary

< Back Continue > Cancel | Help
lf\!

Fig. 3-15  Configuration — SINAMICS CU320 option board

2. An option board is not used in this example.

Confirm the default setting No option board by choosing Continue > to carry
out the next configuration step.
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Configuration - SINAMICS_CU320 - Insert infeed

[0 ption module
st diive This wizard helps you to confiqure a drive unit with  drive
1S ummany and optionally with an infeed.
Are pou using a SINAMICS infeed with
DRIVE-CLIO connection in this drive urit?
% Yes " Na
< Back Help

Fig. 3-16  Configuration — Introduction to SINAMICS CU320

3. In this example, you are using a controlled SINAMICS infeed with
DRIVE-CLiQ connection, an Active Line Module. Confirm the default
setting Yes by choosing Continue >.

Note

If you are using an uncontrolled SINAMICS infeed, click No and then Continue >.

Configuration - SINAMICS_CU320 - Infeed configuration

[Mi0tion moddl=
[Minsert infead

Configure the infeed drive object:

Diive object Mame:  [Infeed

[Clintzed General |

[Clintesd diive obisct - ac

[CIPROFIBUS process dz

[Ciinsert diive Diive obiect ype: [Active infeed ]

C5ummany

Athor,
Wersion

Comment:

< Back Cantinue Cancel Help
Iz\;

Fig. 3-17  Infeed Configuration

4. Click Continue >.
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Configuration - SINAMICS_CU320 - Infeed

W] Option module
W Inzert infeed

[infes corfiguration

[Infeed drive object - ac
[CJFROFIEUS process dz
[CInzert drive

]S ummarg

Infeed: Infeed

Configure the infeed component;

Companent name;

Supply voltage range: ISEU - 480 3-phase WAL ﬂ
Cooling methad: Ilntemal air coaling j
Type: IEvErylhing except Cabinet Elements j
Selection

Order no. | Rated power | Rated curent =
ESL3T30-FTE2T-Bame 1B KW 2T
ESL3130-FTEZ23Bame 36 KW E0&
ESLIT30-FTEZSG4R: BB KW 924
ESLIT30-FTE28-0me  BOKW 1344
ESL3T30-7TEST-Zéme 120 kw 2004
ESL3330-FTESZ18Ax  132Kw 2104
ESLIZ30-FTEZZ 6481 1BOKW 2604
ESL3Z30-TTEZ3-84A% 235 KW 3804
ESL3330-7TE3S-04fx 300 Kw 4904
ESLI330-FTESG14Ax 380 Kw E05 4
ESL3330-7TEZS-448% GO0 KW 2404 po
ESL3I30-7TELT-Dékx B30 Kw 985 4
EiLSSSD-TTEﬂH -AdAy 900 K 1I405 A _>lﬂ

Help |

< Back I Eonllnua)! Cancel |
by

Fig. 3-18

SINAMICS_CU320 configuration for the Active Line Module

5. First choose the appropriate Active Line Module from the Selection field
according to type (order no.) (see type plate), assign a name (Supply_1),
and click the Line filter available field.

6. Click Continue
(see Fig. 3-19).

> to select further data for the Active Line Module (infeed)

] Option module
I Insert infeed

W Infeed configuration
¥l nfzed

[CPROFIEUS process ds
[insert drive
I

Configuration - SINAMICS _CU320 - Infeed drive object - additional

Infeed: Infeed

¥ Line/DC-ink identification at first switch-on
[The determined values are stored safely against power loss].
Caution:
If the DC link capacitance of the dive group is subsequently
changed [remove/add additional devices], the identification must
be performed again.

Device connection valtage: 400 W
Fated supply frequency: IED Hz =

¥ Line filter avalable

™ Parallel connection Infeed (BSLE130:FTE 21 B - 16 k]

Mumber of parallel modules: =
I Wolktage sersing module available
Humberof 5Hs: I _I:
< Back I Continug > I Cancel Help

X

Fig. 3-19

Infeed: further data
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7. Adapt the supply voltage and rated line frequency for the device accordingly.
Click Continue >.

Configuration - SINAMICS_CU320 - PROFIBUS process data EHEh

Infeed: Infeed 1

[V O ption module
[¥]Insert infeed
[Vl Infeed
[Wllrfeed - additional data

Select the PROFIBUS message frame type:

PROFIEUS PZD message frame: |[JEERE e s s aiiglal ™

[(incert drive
]S ummany

Length:

Input data [wards):
Output data (words)

Motes:

1. The PROFIBUS process data will be interconnected to BICO
parameters in accordance with the selected meszage frame lype.
These BICO parameters cannot be subsequently changed.

Fig. 3-20  SINAMICS_CU320 configuration — PROFIBUS process data exchange (infeed)

8. For the infeed in this example, you want a free telegram configuration with
BICO interconnection. Confirm the default setting Free telegram configura-
tion with BICO by choosing Continue >.

Configuration - SINAMICS CU320 - Insert drive

]S Lpply
[W]Infeed - additional data

Do you want to configure a drive [power unit, motar,
encoder|?

[ insert option module

15 ummary
@ Yes " No

The wizard guides you through the drive configuration.

= . If pou want to configure several drives. select
] the element “Insert drive'" in the project navigator

after finizhing the configuration.

< Back l Continue » I Help |

Fig. 3-21  SINAMICS_CU320 configuration — Introduction to the drive

9. You now want to create a drive with a Motor Module (power section), motor,
and encoder for this example. Confirm the default setting Yes by choosing
Continue >.
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Configuration - SINAMICS_CU320 - Drive properties

[w] S upply Configure the drive:
I nfead - additional o @

Hame: IDlive_1

Choose Servo or
Vector.

[C1Fawer unit General |

|‘v"ector 'i

Operating type:

CControl type ¢ setp ;
Cirsert aption modulé | Operating mode:

r
” Author;

Version:

Comment; ‘G etting Started

< Back I Continue » I Help |

Fig. 3-22  Drive properties

10.The drive properties dialog box (see Fig. 3-22) contains general information
about the drive.

11.1n the selection field, choose “Operating type”.
— Servo: when you are configuring a synchronous motor with servo control

— Vector: when you are configuring an induction motor with vector control

12.Assign a name for the first drive, Drive_1, and enter some general comments.
Click Continue >.

Configuration - SINAMICS_CU320 - Control structure

Drive: Drive_1, DDS 0

10 ption module -
[ st infeed
[MInfeed configuratior
W rfeed

[lnfeed dive object
[MFROFIEUS process
[l risert drive

M Drive properties

Function modul

[ Extended setpaint charnel

™ Technology controller

™ Estended messages/manitaring

[CIFower_unit

Closed-oop control————————————
It atar Setpt.
i f =
g?;:zldl;fldmg brake n/M control ] %K
-
% Control method:
ISpeed control [with encoder] LI

—Actual speed value preparation——

< Back. I Continue > ! Cancel Help

Fig. 3-23  Control structure
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13.Choose the “Control method” as shown in Fig. 3-23 (the default setting can be

left as it is) and click Continue >.

Configuration - SINAMICS CU320 - Power unit

[v] Option module |
[ Inzert infeed

v lrfeed

wlrnfeed - additional
[WIPROFIBLS process
[ Insert drive

W] Dirive properties

W] Control structure

[ ]kdotor
[CMotor holding brake |
[CIEncoder

[CICrive functions LI

Drrive: Diive_1.DDS 0

Configure the pawver unit:

Mame: |F'Dwer_umt

Connection voltage: IDE 507204 LI
Coaling method: Ilntamal air cooling j
Type: e =l

™ Only display double motor modules with free conrections

Motor module selection:

Type [order no. Rate. | Rated.. | Exec.. | Codernu.
ESLI1201TE1G-O84: 27 kw BA DC/AC 10002
ESL120-2TE1G088: 27K ba/ . DC/AC 10012
ESLI20-TEZ1-088x  48kKw 94 DCAAC 10003
ESL320-2TE21-088%  4Bkw 94/ DCAC 10013
ESLATA0-1TEZ ] -Bade & e CAAC 10004
BSL3120-2TE21-B080  97KwW 184 DC/AC 10014
ET NINATE2ANA L 1R 1 W& nriar 1ﬂﬂTF_’lLI

& Nofiter/choke
€ Sirusaidal filter
! Dutput choke

Fig. 3-24  Motor Module configuration

14.Choose the appropriate Motor Module from the Motor Module selection field
according to type (order no.) (see type plate) and assign a name (Power unit).

15.Click Continue >.

The following dialog box (see Fig. 3-25) is displayed when you configure an

induction motor with vector control.

Configure an induction motor with servo control and then continue with step 18..
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SINAMICS_S120 - Drive setting

Drrive: Diive 1,005 0

[w] O ption module
[w]Inzert infeed

. Configure the drive properties:
[wInfeed - additio

[WIFROFIBLS proc
[W]lnsert drive
[w]Crive properties
[W]Contral structurs
W] Pz Lt

Standard:

Power unit application:

[t atar
[t atar holding brake
[CEncoder

i

Load duty cycle with high UVEHU&(d

< Back

Help

Fig. 3-25  Drive settings

16.Choose the “Standard” and the “Power unit application” as shown in Fig. 3-25
(the default setting can be left as it is).

17.Click Continue > to select the motor (see Fig. 3-26).

Synchronous
motor

Configuration - SINAMICS_CU320 - Motor

Induction motor

Configuration - SINAMICS_CU320 - Mator

| Diive: Drive_1,DDS 0, MDS O

[@0Fton modle

Wi0pionmodie | Drive: Drive 1,005 0,MDS 0 ]
Winsert infeed [l nset infeed
(Winfeed Configure the motor %:";Eej o Configure the motor
[Firfzed - additional o Name: ot liniesd=adctkns o Hame: Motor
[MIPROFIBUS process i %‘F‘HU[FLBUS process I(_
nset diive 1
Minsert diive £ Motor with DRIVE-CLIE interface EDITVE s Miotor with DRIVE-CLIT interface
W] Dirive properties o s S Cort Sl hniete ™ Fead out mator agan
WICantrol stucture " & Select standard motor from list
' Select standard motor from list 1P e Lt

T " Enter mator data € Enler matar dala

" [CMotor helding brake -
[Ctotor halding brake, Hatarivpe [P 7 induction = encoder Motor type: [TFKE spnchranaus matar =l

Maotar selection;

mul}

Motor selection;

el

TPH7103 D -wlww - 9EA
TPHTA 03D 100, 37. 3BA
TPHT103-wxF il 18/, 55. 134
TPHT103-uxF it /0. 85, 134
TPHP03wGinelnn /200, 7k, 17,
TPH7103 sl m e 200, Tk 17,
TPH7105-uxFui-ul e 150 Tk 17,
TPHT05-xeF e 150 Tk 17
TPHTAO7 D/ 100, B3, 17,
1GUTANT SN s RN ]

|
0. T

IESAM0 K /e BO0.. Q.. 17.. 23603
AKBO4ZwAFTy/one 300 2. 244 23604
FKBM3wAH ke 450.. 2. 44 23605
1FKBO043 s/ Funene BDO.. 2. 444 23606

/ FKB044AFTemer 300.. 3. 44 23607 -
FKBO0S/wbH7emeee  450.. 3. 494 23608
PR/ AP T 300.. 4. 314 23609
FE/OB1 wdF7asoe 300.. 5. 534 23610
1/AB061 wiHPRmee 450, 4. 594 23611
FKBOEZwAF7awe: 300 6. 474 23612

/ AFKANRA.vAFTwwwwe 300 fa 7RA P17 j

18. Choose the motor type.

19. Choose the motor

Help
according to type (order no.).

Fig. 3-26  Motor configuration

18.Choose the motor type:
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— 1FK6 synchronous motor, or

— 1PH7 induction motor

19.Choose the appropriate motor from the Motor selection selection field accord-
ing to type (order no.) (see type plate) and assign a name (Drive_1_Motor).

20.Click Continue > to select the motor holding brake (see Fig. 3-27).

Synchronous
motor

Induction motor

Configuration - SINAMICS_CU320 - Motor holding brake

[0pion mod= a| Drive: Diive_1,DDS 0

Configuration - SINAMICS_CUI320 - Motor holding brake [l

M 0ption moduls a| Drives Drive 1,005 0
et

ins=t infeed
2 nfeed Mator biake seleelion
] infeed - addiional o
GIPROFIBUS proces:

Moter brake selection:

™ with holding brake

TPH 7wt 2ot
TPHT sin-s-dhd V10

- additional ¢
BUS proces:

€ With holding brke

W insert diive ]
propeiiss QL -

W] Contral structure
) P oweer unit
2 ctor

rtrol stucture
[P0 urit
SRR

Encodsr - :
& Wfithout holding brake & & Buithout holding brake

[CIPROFIBUS wnces:j

-

[TPHT e D

Halding brake canfiguratior:

[CIPROFIBUS process

TF KB -ty
TFR Bl

Holding brake configuration:

[Ma metr holding brake installed | [Me matar haling brake installed =l
21. Choose “Without holding E =
brake”.

Fig. 3-27  Motor configuration

21.Choose Without holding brake and click Continue > to select the encoder
fitted to the motor (see Fig. 3-28).
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Synchronous

Induction motor

Configuration - SINAMICS_CU320 - Encoder Configuration - SINAMICS_CU320 - Encoder

&) 0ption module Drive: Drive_1.0D5 0

[ 0ption madule a| Diive: Drive 1,005 0

Which encadr da you want ta use?
nfeed - additional ¢

Which encoder do you want ta use?
¥ Ericorer I~ Encader 2 I™ Encoder3 I¥ Encoder 1 I Encoder 2 I~ Encader 3
ROFIBUS proces< Bl iE IR et
it diive Encoder1 | et drive Encoder 1 |
& properties jive properties
[ Control structure Name: |Murnr el struchue Mame: Mator
1P ovser it
W]t ' Select matar encader from st * Select motor encoder from list
91 otor holding brake € Erlef data Ericorer deta [914ator holding brake  Enter data Encoder data
u
Motor encader selection:

[SIPROFIBLS maces: Motor encode selection:
Type [orderrio) | Ereodertype | Resoltion | Code. | = i |

1FKB we wiun Sindeos iner..  20485/R 2001
1FKBuwwnmusEne  ErDat absol..  20485/R 2051
1Pk G EnDat absol.. 325/R 2052
1FKBuw s S8 Riesolver nspeed 1003

TFKBwn-nnn-wTrn Riesobver 1-speed 100m o9 E Y
o=
L

< Back Help

Fig. 3-28  Encoder configuration

22.Choose the encoder from the Motor encoder selection selection field accord-
ing to type (order no.) (see the type plate on the motor).

23.Click Continue > to choose the control mode/setpoints (see Fig. 3-29).
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[ 0ption module

[“linfeed - additional ©
[MIFROFIBUS process

[VIEncade =

Configuration - SINAMICS_CU320 - PROFIBUS process data exchange (drive):

Synchronous

motor

Diive: Diive_1, DDS 0

Select the PROFIBLIS message frame type:

PROFIBUS PZD message frame;

Length
Input data (words):
Qutput data fwordsk

Motes:

1. The PROFIBUS process data wil be interconnected to BICO
parameters in accordance with the selected message frame type.
These BICO parameters cannat be subsequently changed

Help

ook

Configuration - SINAMICS_CU320 - PROFIBUS process data excha

Induction motor

ok module a| Diive: Drive_1,0D50

Select the PROFIBUS message frame type:

PROFIBLIS P20 message frame:

Lenglh:
.| nput data words) —
o Dutput data (words) —

Notes:

1. The PROFIBUS process data wil be interconnected to BICO
parameters in accordance with the selected message fame type.
These BICO parameters cannot be subsequently changed.

< Back

Help

Fig. 3-29

3-50

Control mode/setpoints

24.For the drives in this example, you want a free telegram configuration with
BICO interconnection. Confirm the default setting Free telegram configura-
tion with BICO by choosing Continue >.

Fig. 3-30

The following dialog box (see Fig. 3-30) is displayed when you configure an in-

duction motor with vector control.

Configure an induction motor with servo control and then continue with step 26.

Cinives Dirive_1

[w]Infeed - additional ca
Dirive properties

Configuration - SINAMICS (U320 - Important parameters

Power unit

Dirive zetting

bdator

E ncoder

[w] Control type / setpc

Matar current limit:
Minimum speed;
t aximum speed:
Ramp-Lip time:
Ramp-down time:

Ramp-down bime with

Set the values for the most important parameters;

[ A

0.000 1pm
1500.000 pm
|1 0.000 =
|1 0.000 ‘
|0.oon S

Help |

< Back I Continue > ‘E!

Important parameters

25.Click Continue > (the default setting for the most important parameters is

“Standard” and can be left as it is).
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Configuration - SINAMICS_CU320 - Summary X

[insert nfeed =] The fallowing data of the diive unit has been entered:
[wirfeed %

Opti dule:
[l infeed - additional o ﬁlljgplmnu:udule =
W] PROFIBUS proces: Infeed
W] Insert diive game‘h’!'?ed_'ll_. S

perating type: Line infeed/feedhacl

E”"e "Impe"‘es Operaling mode: Active ne madule
S¥ICl euCure Drder ni: BSLITI0-TTEZ-GAMK
o] Foiner urit Bated power. 16 ki
o] Mot Rated curent: 27 &
[ viotor holding brake Line fiter. Avalabls

Woltage sensing module: Not available
AiEncader Infeoed - addiional data
W] PROFIBUS process Supply system / D link identification when fisst switched on: Yes
Device connection voltage: 400
Rated supply frequency: 50 Hz
PROFIBUS process data exchange (infeed)
PROFIBUS PZD message frame: Free telegram configuration vith
BICO (339)
Drive properties:
Name: Drive_1
Operating type:
Dperating mode: Servo amplifier
Control struchure:
Control type: Speed contral (with sersor]
Pawer unit |

Copy test o ciphoad |

< Back

Help

Fig. 3-31  Summary

26.Check the summary and confirm it by choosing Complete.

As you can see in Fig. 3-32, the configuration Wizard has created the objects
(including Drive_1) for drive unit SINAMICS_CU320 in the project navigator.

[ STARTER - Project

Praject  Edit Targstsystem View Options ‘Window Help

|JEI|EIEII§HI:I2II£I\ I AN
|

| E|=

x

£8P Project
ve

) Insert si

Loy Overview
L% Configuration
Loy Topology
Contral_Unit
-] Infeed_t
F-423 Inputjoutput companent
=14 Drives
- ) Insert drive
- f Drive_L
L3 Drive navigator
Lo Configuration
Lo Contral logic
% open-loopfdosed-lop control
- Functions
-» Messages and monitoring
+%» Commissioning
- Communication
-% Diagnostics

Project
Press F1 ko open Help display. Offline mode

Fig. 3-32  Project navigator with SINAMICS_CU320

27.Save project Project_2 by choosing Project > Save.

Once you have configured the drive unit with STARTER in OFFLINE mode,
continue with the steps described in Chapter 4 “Starting the Drive Project (Motor
Rotates)”, where you will set the drive interface parameters and start the motor.

|
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Rotates)

This chapter shows you how to start the motor by means of the operator panel
function in the STARTER. The steps for this include:

¢ Loading the project to the drive unit

e Using the control panel

4.1 Prerequisites

The following prerequisites for using the STARTER control panel must be fulfilled:
e The components are assembled (as described in Chapter 2).
e The device unit has been switched on in accordance with the instructions.

« The PROFIBUS Control Unit interface is connected to a PC/PG with
PROFIBUS interface.

e A project has been created using STARTER.
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4.2 Loading the project to the drive unit

To load the project to the drive unit, proceed as follows:

1. If you have not yet opened “Project_2” (created in Chapter 3) or “Project_1”
(created in Chapter 5) in STARTER, open the project by choosing
Project > Open.

2. To use the “control panel” function, you have to switch to ONLINE mode. To
switch to ONLINE mode, click the function key Connect to target system
(as shown in Fig. 4-1).

%7 STARTER - Project_2 = _ 2 x]
Project Targetsystem Yiew Options Window Help

| Djeal = s ol el 7sf% || =)
I 2 o O o e

_——-
B8P Projeet 2

) Insert single drive

E-flp smancs_cuszo

Configuration
Topology

Control_Unit 2. Click

Supply_1
It et Connect to target system.

o Insert drive

[ Drive_L

L) Drive navigatar
L configuration
> Contral logic
Speed control
Functions
Commissioring
Commurication
Diagrostics

i

[ e
YYVYVYY

Froject

Saves the project, connects the project ko the target system and displays the consistency skatus. Offline mode [T [

Fig. 4-1 Project navigator with SINAMICS_CU320

3. An ONLINE connection is established and an ONLINE/OFFLINE comparison is
carried out. If any discrepancies are identified, they are displayed (see the
following screenshot).
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Online/offline comparison x|

The configuration of Drive_unit_addr3 [DYCU3203) online differs  from the project stored offiine. The:
following differences have been detected:

Offline Differences

Online topology Froject topology

CU_003 ( TOCHIUNtS ) | ©U_003 ( TOCtUNits )
&_INF_02 ( TOALM ) £_INF_02 ( TOALM )
SERVO_(13 { TOServoSL ) |[SERVO_03 ( TOServosL )
SERVO_04 ( TOServosL ) | SERWO_04 ( TOServasL )

If thess differences are not adiusted, the orline representation may be incomplets

Adiust vis
<==Dowrload Overwiting of the data in the target device

Load to PG ==» Owenaniting of the data in the project

Diive_unit_sddi3

Fig. 4-2 ONLINE/OFFLINE comparison, load to target system

4. You changed the data OFFLINE and now have to load it to the target system.
Carry out the following:

— Click <— Load to target system in the “ONLINE/OFFLINE comparison”
dialog box.

— When the system asks “Are you sure?”, click Yes. The system now starts
loading the data.

— When the system informs you that the data was successfully loaded to the
target system, click OK.

— Click OK for “Load from RAM to ROM”.

5. Discrepancies were identified again during the ONLINE/OFFLINE comparison.
Click Load to PG —> (see screenshot below).

Online /offline comparison r x|

The carfiguration of Diive_unit_addi3 [DYCLIZ205) anline difers From the project stered offine. The
following diferences have been detented

Offline Differences

Online topology Project topology
SERYO_03 ( TOServosL )| SERVO_D3 ( TOServasL )
SERVO_04 { TOServosL )| SERVO_04 ( TOServosL )

IFthesa diferencas are not adjusted. the oniine repiesentation may be incomplete:

<==Download Dvemiting of the data in the target device
Load0PG =[] Overwiing ofthe data i the project

Adiust via

Drive_unil_sddr3

Close Hilfe
Fig. 4-3 ONLINE/OFFLINE comparison, load to PG

6. Load the new data from the drive unit to the PG. Carry out the following:

— When the system asks “Are you sure?”, click Yes. The system now starts
loading the data.
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— When the system informs you that the data was successfully loaded to the
PG, click OK.

7. No further discrepancies are displayed in the ONLINE/OFFLINE comparison
dialog box. Click Close (see screenshot below).

Online/offline compar: x|

The configuration of ([DVCU3205) online differs nat from the project stored offling. The following
diferences have been detected

Oifline Differences

If these differences are not adiusted, the onling representation may be incomplete.

Adust via
<==Donnload Overwwiting of the data i the target devics
Lozd to Pi=—> Overvwiting of the dala inthe proiect

Diive_unit_sddi3

Close: Hilte:

Fig. 4-4 ONLINE/OFFLINE comparison, close

Note

When loading the project, note the LEDs on the Control Unit. The Control Unit is
ready for operation when the LED RDY is continuously lit (green).

This completes the procedure for configuring the drive unit hardware. The following
section shows you how to use the control panel in STARTER.
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4.3 Using the control panel

Once you have established a connection with the target system and loaded the

project to the target system, a green plug icon appears in front of the drive unit and
other configured components in the project navigator. This indicates that the proj-

ec

t data in STARTER and the target system is consistent (see Fig. 4-5).

The drive unit is ready to run.

To use the STARTER control panel and start the motor, proceed as follows:

[P STARTER - Project_2 ==

Project Targetsystem Visw Options WWindow Help

| Dlslei 5 (e oo | Fe sl ) S
Q1 e e 4 T e ) “ﬁlﬁl”ﬂl”ﬁi*'i\

=

@ Project_2
- T ert single drive

5 Hrs |

P> Overview

e
ol
< Supply_L
Inputfoubput compons-
Drives
W7 e
- A orive _t

. p Drive navigator

Green plug icon.

» Configuration
o p Control lagic
B3 Speed control
- Functions
=% Commissioning

R

. -
B3 Commurication
[ Diagnostics

Double-click Control panel in the
project navigator.

x

Project
Device [ Operating made |
SINAMICS_CLI320. Contral_Unit Ready
SINAMICS_CLI320 Supplp 1 122 he Signal ‘EINASUST* mit 01 Flarke setzen [p0340)
SINAMICS_CL320 Diive_1 Mo details
SINAMICS_CLI20, nput_autput_companent_1 Mo detals

i Alarms § T arget system output E Topology output %% Diagnostics overview

Pre:

55 F1 ko open Help display. [Online made

Fig. 4-5 Control panel

1.

Double-click Control panel in the project navigator under
Drive_1 > Commissioning (see Fig. 4-5).

The control panel is displayed in STARTER (see Fig. 4-6). You can use the
control panel to control the drive directly from the PC/PG.
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4-58

[F STARTER - Project_2

Project Control pansl Targstsystem ‘isw Options ‘Window Help

=l&l=l

J_I_I_H_IIMEII:I:I\_IJI_EIEI_IJ!IEI
[FRES =L | B @@ || x|l 28| atafal ]

=Ep Project_2
-] Insert single drive
Bl SINAMICS_CU3z0
“ Y Owerview
> Configuration
~ % Topology
e

i

[=_{ Drives
) Insert dhive:

B @ Drive_1

Lo Drive navigator
> Corfiquration
e > Control logic
&% Speed control
- Functions
E » Commissioning

B-% Communication
» Diagnostics

Click Assume control priority.

Project

- /
SINAMICS_CU320 - Dnve1
Setpoint [1007) Seeing Telpt
Assume contral pric 2 JJJ — }
I:§ T oo | — |. T o
'_ Enables ssumereturn control priority 0% fomx  z00% 100%

. Alams g Control panel E Target system autput | B Topology output | % Diagnostics averview

Press F1 to open Help display,

Fig. 4-6

|Online mode

Assuming control priority

2. Click Assume control priority to connect the control panel to the drive inter-

face.

Note the message that is then displayed in the Control priority dialog screen.

This message is very important (see also Fig. 4-7).

Danger
Use control priority with care!

The function should be used for commissioning, diagnostics, and maintenance

purposes only.

Make sure that the drive is in the “OFF” status and that no ON/OFF1 command
has been issued either by the control word for sequence control or another signal

source (e.g. BICO interconnection).

Once control priority has been transferred to the PC, the BICO interconnections on

bit 1 to bit 6 of the control word are no longer active.
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Control priority at PC - Drive_ 1 .SINAMIC

You can use the default monitoring time
(e.g- 3000 ms).

Application monitaring: =
[0 -» no manitaring) Im Mg
Tip:

To speed up the responsze, it iz recommended that pou increase the baud
1ate and close all unneceszary windows.

Be careful when uzing the control prioritg!
The function should only be used for commizsioning, for diagnostics or
during maintenance wark.

Please ensure that the drive is in the
"0FF" mode and no OM/OFFT command £ e
another signal source [e.q. BICO interconne

To continue with commissioning, choose
After transfering the control priority ta the 21 QK
on Bit 1 ta Bit B of the contral word <& not ¢

QK. /; Cancel Help. ..

Fig. 4-7 Transfer control priority to PC

You can enter an application monitoring time, which is the time that elapses be-
tween two setpoints before the sign-of-life monitoring function on the drive re-
sponds (fault 1910).

You can use the default monitoring time (e.g. 3000 ms).

3. Since our example concerns commissioning, confirm this dialog box for assum-
ing control priority by choosing OK.

*
[SIHAMIES_CUZ20- Drive 1 = [mfe
Setpoint (100%)
Fetum JJ =
Stop w. space bar - always works! Cli
ick
33 hex] Signal 'BB/AUSZ auf '1" setzen (p034E. . q . - .
ElETm T el PR ooy o [ Display/hide diagnostics view.
N Motor spsed 00 | o
ON / DFF 2
ON ¢ DFF 3 Moor utfiastion: 0.0 % Motor curent 0.0 A

Pulse enable

Flamp-et generator enatle
Start/stop rampfunction gen.

P, () Setpoint enable (O Enables avala Diagnostics

& 2ams #g. Conticl pane] | Tnget system output |
Press 1t open Help dplay. Status “lamps” for the control word bits. fae [

Fig. 4-8 Diagnostics view

4. To display, amongst other things, the status lamps for the control word bits,
click Display/hide diagnostics view.

Table 4-1 lists the most important digital input signals of the control word for
sequence control. You need these to set the motor in motion and issue them via
the control panel for the Control Unit (CU320).
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Table 4-1 Control word sequence control
Signal (control PROFIdrive Meaning
panel) bit no. in CTW
sequence control
ON/OFF1 Bit 0 0 = OFF (OFF1), stop via ramp-function generator,
followed by pulse block
1 = ON, operating condition
ON/OFF2 Bit 1 0 = Coast down (OFF2), pulse block, motor coasts
to standstill
1 = Do not coast down, operating condition
ON/OFF3 Bit 2 0 = Emergency stop (OFF3)
1 = No emergency stop, operating condition
Pulse enable Bit 3 0 = Disable operation, pulse block
1 = Enable operation, enable pulses
Enable ramp- Bit 4 0 = Set ramp-function generator to 0
function 1 = Enable ramp-function generator
generator
Start/stop Bit 5 0 = Freeze ramp-function generator, retain
ramp- current output value
function 1 = Restart ramp-function generator, follows the
generator input value
Setpoint Bit 6 1 = Enable setpoint
enable 0 = Inhibit setpoint and set to 0
o [SIMaMICS_CUS20- Drive_1 = Elﬁ
Setpaint [1007%) Scaling Setpt,
EEE ) G DHﬁHP—D } ’ Lé el h
[33 hex] Signal > 'Aug§;fu| 1" setzen ||
Mater| .
oo 2 Click the
Pk enle vl Enables field.
Riamp-fct generator enable
A s e vt
_.A\avmsﬂ Eoniiol panel | [ Target system output | [ Topelogy output ] %5 Disgnostics overview
Press F1 to open Help display. |Online mode 0 [

Fig. 4-9 Enables

5. As shown in Fig. 4-9, click the Enables field to set the commands for enabling
the control words in the drive system.

o [EiNaMIES_c0z20 - Dive_1 = IEIE
Soport(007)] [ Gedng  Gemt
¥ Enables Stop w. space har Wi works! o o0 1003
[21 hex] Slgnfééﬁf&%%lb;:m Click
otor spesdt . .
LD e Infeed control priority.
Fig. 4-10 Infeed control priority

6. Click Infeed control priority. The infeed (Active Line Module) is switched on.
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7. Before starting the motor by choosing Motor on (see Fig. 4-11), you have to
make the following settings:

— Enter a speed setpoint (e.g. 50 revolutions per minute).

— Use the slider to set the setpoint in %. Position your cursor on the slider,
hold down the left mouse button, and set the speed to 0%.

ii Danger
During commissioning, note the machine traversing range and take appropriate
external measures (e.g. monitoring the limit switch).

*
[SIMEMICS_Cuz20 Dive = (me
Sopon (1009, [ SeAng [ Selt
Fetun BN |, [ ——1] 7 m
[¥ Enables e . cpeED har—a"lys — \\ N oz
21 hex] Signal ‘EIN/AUST® mit [i/1-Flanke
L 1Sia Setzen (p0840) Speciied \ Actual Smaothed diive output freque
Motor speed 00 ) 0 rpm 00 Hz
(C)on 2 OFF 1

8. Drive on
Speed setpoint: 50

Percentage to 0%

Fig. 4-11  Control panel before “Drive on”

8. Click Drive on. The ON/OFF1 “enable” command is set and displayed on the
control panel (see Fig. 4-12).

9. Increase the speed slowly

from 0 to 100%.

ON/OFF1 “enable”
command set.

(e

=5 atpoint (100%] -~ Sealing '7 Setpt
[Asturn... J. :ll—EEI o . J— _ l_ﬁ‘ -
Stopw spa:ahar-a\way341k3‘ i 102%

/

N /OFF 1

[00 hex] Enable all Speclied  Actual Smoothed diive output freque
M [tor speed 510 510 om

10. Stop I

Fig. 4-12  The motor starts to rotate

9. Move the slider for the speed slowly from 0 to 100% (see Fig. 4-12).
The motor starts to rotate.

10.When you click Stop, the motor stops. You can also trigger a fast stop by
pressing the space bar.
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The following steps show you how to return control priority to terminate the con-

nection to the drive:
— Infeed
— Control Unit

*
[sINaMICS_CU320 - Drive_1

o [mle

W Enables Stop w. space bar Ve works!

Setpoint [1002) Scaling
Retum.. IEDJ I_EEI m . ’7__J_ _ ’7

50 1pm
100

[21 hex] Signal 'EIN/AUS1" mit 0/1-Flanke

setzen (p0840) Spetnd Click
Motor speed: |_P_nn
Q ON / OFF 1

Fig. 4-13  Infeed control priority

11.Click Infeed control priority (see Fig. 4-13).

Infeed control priority.

[33 hex] Signal ‘BB/AUS3" auf ‘1* seiee<
08

Return....

Motar
(oM 4 OFF 1

=
[5inarics_cuaz0-rive1 | IEIE
Setpoin (1002) Scalng
fellin J_ [ 50 ipm w IV'_J— = [ 50 tpm
e
Click

Fig. 4-14 Infeed control priority

12.Click Return... to terminate the connection to the drive unit (see Fig. 4-14).

Return control priority? (IACP:221)

ds from set

Make sure that no O command from the CPU [automation]
iz pending.

EBefore removing the control priarity, the PC remaves all
enables, BUT the setpoints and commands subsequently
come fram the parameterized sources again. If a setpaint iz
pending, the drive reacts immediatel!! This can be
dangerausz!!

Do pou want to continue?
es hl Mo |

Return control priority

Fig. 4-15

13.Confirm the query Return control priority? with Yes (see Fig. 4-15).

4-62
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The system then returns to the project in STARTER (see Fig. 4-16).
JL.IE|

Project Controlpanel Target system View Options Window Help

JEIEIEII_HAI%IEII:I&H_HI_&I&H_HIE
| 3=

b |28 | e | 2 | @ | @ | 0] | 2] s ] 1] %

=8P Project 2
- # Insert single drive
=-fll, sinAMICS_Cuzzo
> Overview
5 Configuration
» Topology
‘Control Uit
Supply_t
utjoutput componert
4 Drives
] Insert drive
=< ] Drive_1
> Drive navigator
+> Corfiguration
> Contrallogic
>> Speed control
$ Functions
) (ummlssmmng

mE-E
Wy

> Communication
» Diagnostics

EE
vy

Profect
M [S&MICS U0 Dme T = [mle

_ JJ Selpont (100%) Scalng Selpt =
ssue corlrol poily

[~ 50 om — | 50 P
I Eratles o oo 2oz 100%

[21 hex] Signal EIN/AUS] mit 0/1-Flanke S thed vy —
setzen [p0840) Specified  Actual moothed diive output freque,
wocrspest [ 08 [ T | 0o He | =l

. Slas 1 “Exriiaipand [ Target system cutput | [ Topology output | %0 Diagnastics averview |

Press F1 o open Help display.

Fig. 4-16  Commissioning complete

[online mode I

Congratulations!

You have successfully completed commissioning a drive using the SINAMICS
S120 drive system.
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This chapter shows you how to create the sample project ONLINE by carrying out
the following steps:

¢ Create a project.

e Enter and configure the component topology and configuration of the drive unit
automatically.

e Configure the drive motors and check the topology.

5.1 Prerequisites

The following prerequisites must be fulfilled before you create a drive project
ONLINE with the STARTER commissioning tool:

e The components are assembled (as described in Chapter 2).

¢ The device unit has been switched on in accordance with the instructions.

« The PROFIBUS Control Unit interface is connected to a PC/PG with
PROFIBUS interface.

The SINAMICS firmware is able to recognize the actual topology automatically and
store it in the appropriate parameters.
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5.2 Creating the project
To ensure that the drive unit configuration is identified automatically, open a new
project in STARTER:
1. To start the STARTER commissioning tool, click the STARTER icon or choose
the following menu path in the Windows start menu:
Start > SIMATIC > STEP 7 > STARTER.
The Project Wizard Starter is displayed.
Project Wizard Starter x|
. 2 L 4
Intraduction Create FG/PC - Set Inzert drives Surmmary
new project interface
Arrange drive unitz
offline...
Find drive units
orline... -
1. Create new project
2. Set up interface
3. Search for drive unitz and
ingert in the project
[hd L=y v Qi W g saan
Cancel |
Fig. 5-1 Project Wizard Starter
2. Choose Find drive units online... (see Fig. 5-1).
© Siemens AG, 2004. All rights reserved
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The Wizard guides you through the procedure for creating a new project.

Project Wizard Starter

x|

1.
Create
new project

Introduction

2, 3: 4
PGAPC - Set Inzert drives Summary
interface

Please enter the project data:

Project name: IF'IDin_4
Authar |Doku
Comment:
Getting Started ;I
e

< Back | Cantinue > |

Cancel |

Fig. 5-2

Creating a new project

3. Enter the project name (e.g. “Project_1”) and, if required, the author and a

comment (see Fig 5-2).

4. Click Continue > to set up the PC/PG interface.

Project Wizard Starter x|
1 2 3 4.
| nbroduction Create PGAPC - Set Inzert dives Summary
new project interface

Specify the online connection to the dive urit;

Set
interface: CPA5T1[FROFIBLS)
. 1@
Change and test... ’}J
< Back Contlnue 5 Cancel |

Fig. 5-3

Setting up the interface

5. In this example, you require a PROFIBUS interface on the PC/PG (e.g. PC
adapter (PROFIBUS). Choose Change and test and confirm your selection

with Continue >.
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5-68

The project Wizard searches for the drive unit ONLINE and inserts it in the
project. Once the drive unit has been found, the project Wizard displays it in the
preview screen (see Fig. 5-4) along with its PROFIBUS address
(Drive_Unit_Adr10).

Note

The system searches for drive units or, more precisely, Control Units; in other
words, if more than one Control Unit exists in the system, more than one drive unit

is found.

The peripheral components of a drive unit (Control Unit, Active Line Module, and
so on) are not displayed until you load the drive unit configuration to the PG/PC.

Project Wizard Starter x|
1. 2 3 4
Introduction Create PGEAPC - Set Inzert dives Summary
hew project interface
— Preview
E--% Project_1
Eleﬁ' Cirive_unit_addr3
Search for

reachable nodes

< Back | Caontinue » I

Cancel |

Fig. 5-4 Inserted drive unit

6. Click Continue >.
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The project Wizard displays a summary of the project

(see Fig. 5-5).
Project Wizard Starter |
. A 3 4
Intraduction Create PG/PC - Set Inzert dives Summary
new project interface
The following settings have been selected: ;I

- Praoject name: Project_1
Storage location: d:A\SiemenshStep?hS7profProjec_5

- Interface: CPE511[FROFIBEUS)
- Drive units:

Drive_unit_addrg [SINAMICS_S120 [B5L3xms-whdmmm- s

a | 3|

Fig. 5-5 Summary

7. Click Complete. The new project and drive unit are displayed in STARTER
(see Fig. 5-6).
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53

5-70

Entering the component topology and configuring the
drive unit automatically

Once you have created the project and entered the drive unit with its PROFIBUS
address ONLINE, you have to enter the associated component topology and drive
unit configuration ONLINE.

% STARTER - Project_1 E —|&] x|

Project Target system Wiew Options Window Help
JEIEIEH_H\ilzI\_I c=l e || 2| B
|/ |®|| || 23] | atalsa+1e[%]]

J

E@P]u

_1 e snge dive
s

- Contral /i

2. Choose
Connect to target system.

1. Select the drive unit
Drive_Unit_Adr10.

Project
Press F1 ka open Help display. Offline mode

Fig. 5-6 Project_1

—

. Select the drive unit Drive_Unit_Adr10 in the project navigator.
2. Choose Connect to target system.

3. Select the drive unit Drive_Unit_Adr10 in the project navigator.
4

. Choose the Restore factory settings function key (see screenshot below).

e

Project Edit Targetsystem Yiew Options Window Help

|| Do) 2] | @] o] M) oo i | 2] | | e e s [ o = IEIKIOOH | xell)| 2]

I

= IBR T e = i

4. Choose
Restore factory settings.

Fig. 5-7 Restore factory settings

5. Confirm the following queries and messages by choosing OK:
— “Restore factory settings?” dialog box
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— “The factory settings have been restored” dialog box
“The data has been successfully copied from RAM to ROM” dialog box

[FFSTARTER - Project_1 =i —1&]x]

Project Targetsystem View Options Window Help

| D] S| & |ml ]| =] 22 || e el %l || 22| B
| ol s = [ o | | 201 | 153

=8P Project_L
B Insert sindle drive
= f2fl, Orive_unit_addra
L&} A Ltomatic configuration
> Overvisw
> Configuration

> Topology
Double-click
Automatic configuration.

M Contral_Unit

Praject

Device [ Operating mods ]
Drive._unit_addh Ready

ima.m [ Tarmet system ouiput 4§ Diagnostics overvisw |

Press F1 to open Help display. [Online mode [T 7T

Fig. 5-8 Automatic configuration

6. In the project navigator, double-click Automatic configuration under the drive

unit.
Automatic Commissioning x|
Status of the drive unit: IInitiaIization finizhed
Dirive: object type: IServo j
Upload type: Complete uplead
Running operation; “waiting for 51 Click

Start automatic configuration.

Loadto PG (Unoad) |/

Fig. 5-9 Automatic commissioning

7. ClickStart automatic configuration.

STARTER automatically searches for all drive unit components that are con-
nected properly and then uploads them. In this case, it has recognized a drive.
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Drive Object Type L

/> Sevn
A

i Selection of the supported drive object types

 Yector

Dr/ue

Identification

Drive 1

I_ Drive object type
B

ervo -

Idertification via LED

Drive 2

|serva -

Idertification via LED

Choose Servo.

< Zuriick: I Fertig stellen I

Abbrechen

Fig. 5-10  Automatic commissioning

8. In the “Drive object type” dialog box, choose Servo and then click Complete.
The system now loads the data from RAM to ROM and to the PG.

Automatic configuration (ISD¥:413)

i)

Pleaze remember to also configure the motors on the following diives:

SERVO_03
SERVO_04

Please perform the following steps:

Go offline.
Run through the drive wizard on the appropriate drive and on the infeed if one iz available.

Fig. 5-11  Message

9. The system outputs another message listing all the drives for which you have to
configure the motors in OFFLINE mode. Click OK to confirm the message.

Note

The drives are equipped with standard motors.

If a drive is equipped with a motor with a DRIVE-CLIQ interface, the motor does

not need to be configured in OFFLINE mode.
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Automatic Commissioning ﬂ
Status of the drive unit: IInitiaIization finizhed
Dirive object type: |Servo j
Upload type: Complete upload
Running operation: Automatic commizsioning iz
completed

) Close
Cloze | 4

[ LoadioPG Wpbag) |

Fig. 5-12  Close automatic commissioning

10.0nce the automatic commissioning is complete, click Close.

In the project navigator, all the drive unit components that have been found are
displayed with, for example, the Control Unit, infeed, and drive
(see Fig. 5-13).

=181 x|

*F STARTER - Project_1L
Project  Target system Yiew Options Window  Help

BE
| 89| a1

I__I_IH_I

JDBH\_IHHEI:&H_I

&P Project_1

) Insert single drive

B -ﬂlé, Dnve_umt_adura

F > [nnflquratmn

> Topology

[ Control_Unit

» Configuration
8= InpUbsfoutputs
» Communication
2 Diagnostics

'ﬂ Supply 1

Inputjoutput componsnt
(=] Drives
%) Insert drive
A Drive_t . . .
Configuration with, for example, Control
Unit, infeed, and drive.
Project
Level | Message -

Infermation The following devices are not consistent onling: Drive_unit_addr8

Informatian Drive_urit_addrB: Upload completed
| | »

iA\arms B Target system output 5 Loadto PG ouput [ %€ Diagnostics averview

Press F1 to open Help display.

Fig. 5-13  Automatic configuration

|Online mode [ [

11.Choose Disconnect from target system.
The drive unit, components, and drives are installed in the STARTER project.
You now just have to configure the drive motors and check the topology.

To do so, proceed as described in Section 5.4.
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5.4 Configuring the drive motors and checking the topology

Now that you have entered the component topology and configuration for the
drive unit and integrated these in the STARTER project automatically by
carrying out the steps described in Section 5.3,

carry out the following steps to configure the drive motor and check the
topology.

[P¥ STARTER - Project_1 = _[2]x]

Project Targetsystem View Options ‘Window Help

JE
) 251 al 1[5

| Dl@)| = f= (] =] || =l || =
| H o= o (o || %]

x

=& Praject_1
%) Insert single drive
Eflla Drive_unit_sdidre
L D Owerview
e > Configuration
i > Topology
=1 Contral_Unit
i > Configuration
i 8= Inputsfoutputs
» Communication
> Diagnostics .
Sopp1 Double-click
Inputfoutput component = =
£ S ores Drive navigator.
7 Insert drive
-l Drive_1
B ncvioztor Bl
> Configuration
> Control logic
B3 Speed contral
B3 Functions
&3 Commissioning
- Communication
- Diagnostics

s e B s —

Project
Level | Message |
Informalion Dirive_unil_addié: 5 abiects not contained in the praject et on the contral
Infarmation Drive_unil_addi: Not all data is up-to-date on the contral
4] B

B Torget system output [ Loadto PG output ]

Press F1 to apen Help display. Offline mode

Fig. 5-14  Project_1 configuration

1. In the project navigator, choose the Drives folder and double-click Drive
navigator under the drive.

The Drive Navigator dialog box provides an overview in which you can
configure the main drive functions.
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EIDrive_l - Drive navigator = |EI|1|
Y
=) - Setpointz from higher-level control
Q
- g
S tnnink denntin . hat
1] Click _)I_I
/ Device configuration.
Device configuration Cammigsiomning Diagnestics/optimization Senice
i king in: Ch tax
S HEEna —_— e OrineMods Set PG/PC nterface...
4| | B
m ¢-| Cloze | Help |

Fig. 5-15  Drive navigator

2. Click Device configuration to configure the drive motor.

Device configuration

| Click
Carry out drive
configuration.

‘w/hat do you want to do?

INg | >
Carry out drive configuration Check topology
|

Fig. 5-16  Device configuration

3. ClickCarry out drive configuration. The project Wizard for configuring the

drive is displayed (see Fig. 5-17).
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Configuration - SINAMICS_CU320 - Control structure

10 ption module -

Drive: Drive_1, DDS 0

] Irsert infeed
[MInfeed configuratior
W rfeed

[lnfeed dive object
[MPROFIBUS proces:
[l risert drive

M Drive properties

Function modul

[ Extended setpaint charnel
™ Technology controller

™ Estended messages/manitaring

[CIFPower_unit
[CIhictar
It atar holding brake

1Y

Closed-oop control————————————
Setpt.
o
Sl » ndi control

Caontrol methad:

ISpeed control [with encoder] LI

@

—Actual speed value preparation——

To work through the Wizard,
choose Continue >.

Help |

« Back I E:nntir'n.n:,[;lS Cancel I

Fig. 5-17  Project Wizard

4. Work through the Wizard by choosing Continue > until you reach the point at
which you configure the motor (see Fig. 5-18).

Note

You only have to change the motor configuration; leave the infeed etc. as they are.

Configuration - SINAMICS_CU320 - Motor

[w] O ption rnodule =

Drivve: Drive_1, DDS 0, MDS 0

v Inzert infeed

vl rfeed

[w|nfeed - additional o
[WIFROFIBUS proces:
W] nzert drive
[wlCirive properties

W] Control structure

[ Poer unit

Mame:

[t ator holding brake__|
[CIEncoder
[C]Dvrive functions LI

tator type:

Iotar selection:

Configure the motor:

atar

 Motor with DRIVE-CLIT interface
I Read cut motor agait
% Select standard mator from list

" Enter mator data

5. Choose the motor type.

|1FKB synchronous motor

'ﬂ

=t | T

5-76

TFKBD/0wAK T -snn
TFKY 4245 T
1P/ B043-wAH T -nnn
/K EOA 3w T
TFKED44-wAF Fu-wun
| 1FKB044-n4H Prnmnn

MR

6. Choose the motor s
according to type
(order no.).

MERE
[MERE
e

.
o
=]

DO EMEWLDRNMNMNOD

0

< Back

Help |

Fig. 5-18

Motor configuration
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5. Choose the motor type:
— 1FK6 synchronous motor

— 1PH7 induction motor

6. Choose the appropriate motor from the Motor selection selection field accord-
ing to type (order no.) (see type plate) and assign a name (Drive_1_Motor).

7. Click Continue > and work through the Wizard until the summary is displayed

(see Fig. 5-19).

Note

You only have to change the motor configuration; leave the infeed etc. as they are.

Configuration - SINAMICS_CU320 - Summary - .

[¥] I nsert infeed |  The following data of the dive unit has been entered:

] e =
[wlInteed - additional ¢ Dﬁfggg:;:u::odme
[WIFROFIBUS proces: Infesd:
] nsert drive Mame: Infeed_1
i Operating type: Line infeed/fesdback
= Operating mode: Active line module
O b Order no. BEL3130-FTEZ 144
] Power unit Rated power: 16 ki
[l ot Rated current: 27 A
1 halding brake Line fileer: Aswailable
%:Iri[c‘\d; Ifrig bk Waltage sensing module: Not available
T Infeed - additional data:

Device connection voltage: 400V
] Fiated supply frequency; 50 Hz
PROFIBUS process data exchange [infeed):

EICO [339)
Dirive properties:
Mame: Drive_1
Operating type:
Operating made: Servo amplifier
Control stucture:
Control tppe: Speed control [with senzor]
Power unit:

Copy text to clipboard

[WIFROFIELS process Supply system / DC link identification when first switched on: Yes

PROFIBUS FZD message frame: Free telegram configuration with

< Back

Help

Fig. 5-19  Summary

8. Click Finish.

Before saving the project, check the topology in STARTER.
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Device configuration x|

Click

What do pou want bo da?

w1 il QL

Carry out dive configuration Check topology

|

Fig. 5-20  Device configuration

9. Click Check topology.

B STARTER - Project_1 - [Drive_unit_addr8 - Topology]

s
[ Project Targetsystem View Options Window Help

Check topology.

LS|
_lsix|

Choose

Project > Save.

Topolagy | Frojectset | Set Aol Vergleich -

o) Owerview Control_Unit {1}
Y Configuration
r ; Tupu\igy =[G Supelv_t (2)
-8 Control_Unit Free
¢ = > Configuration E Free
i 8= Inputsjoutputs = Drive_{ Power_unit (3)
i » Communication i B Free
% Diagnostics
Supply 1 e [ZFTG[) Drive_L.SMC2Z0_to_Motor {S)
Tnputfoutput companent Free
B Enves Free
) Insert drive —4—DI Input_output_component_
- Drive_1
>
> Configuration
> Control logic B component depat
» Speed contral Free
3 Functions

B3 Commissioning
F-3% Cammunication
#-3» Diagnastics

Fiter: | DRIVE CLIQ + Option Slat

Updt topoiogy Close Help
Froject £ Drive 1 g Diive_unit_add® |
x
Level [ Message
K1) (3]
B Torget system autput |§ Load to PF output [E] Topolagy output
Press F1 to open Help display. Offline mode

Fig. 5-21  Topology tree

10.1n this window, check the topology and DRIVE-CLIiQ connection and compare

this with the actual topology (see Fig. 5-21).

11.Choose Project > Save and save the project under the name “Project_1”.

To start the motor, continue by carrying out the steps described in Chapter 4.
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Glossary

Explanation of this glossary (abridged)

German term English term Abbrev.1

Definition of the term in English 1) — if available

Explanation of this glossary

Active Line Module Active Line Module none

Controlled, self-commutating feed/feedback unit (with —> “IGBT”s in feed/feedback
device), which supplies the DC link voltage for the —> “Motor module”s.

Antrieb Drive none

The drive includes the motor (electric or hydraulic), the actuator (converter, valve),
the Control Unit, measuring system, and supply components (Line Infeed Module,
pressure reservoir).

For electric drives, a distinction is made between a converter system and an in-
verter system. With a converter (e. g. — “MICROMASTER 4”), the line infeed, the
actuator, and the control component form a single device from the point of view of
the user. With an inverter system (e. g. — “SINAMICS S”), the supply is ensured
by means of a — “Line module”, thereby realizing a DC link to which the —> “In-
verters” (—> “Motor module”s) are connected. The — “Control unit” is implemented
as a separate device and connected to the other components by means of

—> “DRIVE-CLIQ".

Antriebsgerat Drive Unit none

The drive unit includes all the components connected via — “DRIVE-CLIQ” that
are required for carrying out drive tasks: —> “Motor Module” —> “Control Unit”
—> “Line Module” and the required —> “Firmware” and —> “Motor”s, but not addi-
tional components (e.g. filters and reactors).

Several —> “Drive”s can be implemented in a drive unit.

See —> “Drive system”

© Siemens AG, 2005. All rights reserved
SINAMICS S120 Getting Started with the STARTER Commissioning Tool — 06/2005 Edition B—81



Glossary

Antriebskomponente Drive Component none

Hardware component connected to a —> “Control Unit” via —> “DRIVE-CLiQ”, for
example.

Drive components include: — “Motor Module”s, —> “Line Module”s, —> “Motor’s,
—> “Sensor Module”s, and —> “Terminal Module”s.

The overall arrangement of a Control Unit including the connected drive compo-

nents is called a —> “Drive unit”.

Antriebsobjekt Drive Object DO

A drive object is an autonomous, individual software function with its own —> “Pa-
rameter’s. It may also have its own —> “Fault’s and —> “Alarm”s. The drive objects
may exist by default (e. g. On-board I/O) and may be easy to create (e. g. —> “Ter-
minal board” 30, TB30). It may also be possible to create more than one (e. g.

—> “Servo control”). As a rule, each drive object has its own —> STARTER window
for parameterization and diagnostic purposes.

Antriebs-Parameter Drive Parameter none

Parameters of a drive axis that include, for example, the parameters of the corre-
sponding controllers, as well as the motor and encoder data. The parameters of
the higher-level technology functions (positioning, ramp-function generator), how-
ever, are called — “Application parameters”.

See —> “Basic unit system”.

Antriebssystem Drive system none

The drive system includes all the components in a product family (such as SI-
NAMICS) that belong to a drive. A drive system comprises, for example,

—> “Line Module”s, —> “Motor Module”s, —> “Encoder’s, —> “Motor’s, —> “Terminal
Modules, and —> “Sensor Module”s, as well as additional components (reactors,
filters, cables, etc.).

See —> “Drive unit”.

Antriebsverband Drive line-up none

A drive line-up comprises a —> Control Unit and the and the —> Motor Modules and
—> Line Modules connected via — DRIVE-CLIQ.

Basic Infeed Basic Infeed none

Overall functionality of an infeed with —> Basic Line Module, including the required
additional components (filters, switching devices, and so on).

Basic Line Module Basic Line Module none

B-82

Unregulated Line Infeed Unit (diode bridge or thyristor bridge, without feedback) for
rectifying the line voltage of the — “DC Link”.
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CompactFlash Card CompactFlash Card none

Memory card for non-volatile storage of the drive software and corresponding
—> Parameters. The memory card can be plugged into the —> “Control unit” from
outside.

Control Unit Control Unit CUxxx

Central control module in which the closed-loop and open-loop functions for one or
more —> “SINAMICS” —> “Line Module”s and/or —> “Motor Module’s.

There are three types of Control Unit:

— SINAMICS Control Units, z. B. —> “CU320”

— SIMOTION Control Units, e. g. — “D425” and —> “D435”

— SINUMERIK Control Units, e. g. NCU710, NCU720, and NCU730

Cu320 Cu320 none
SINAMICS —> “Control unit” with 4 — “DRIVE-CLiQ socket’s and 16 digital inputs/
outputs.

Double Motor Module Double-Motor Module none
Two motors can be connected to and operated with a Double Motor Module.

See —> “Motor Module” —> “Single Motor Module”
Former term: — Double-axis module

DRIVE-CLiQ DRIVE-CLiQ none
Abbreviation of “Drive Component Link with 1Q”.

Communication system for connecting the different components of a SINAMICS
drive system (e. g. —> “Control Unit”, —> “Line Module”s, —> “Motor Module’s,

—> “Motor’s, and speed/position encoders.

The DRIVE-CLIQ hardware is based on the Industrial Ethernet standard with
twisted-pair lines. The DRIVE-CLIQ line provides the transmit and receive signals,
as well as the +24 V power supply.

Einspeisung Feeding Section none

Input component of a converter system for generating a DC link voltage to supply
one or more —> “Motor module”s, including all the required components (e.g.

—> “Line module”s, fuses, reactors, line filters, and firmware, as well as propor-
tional computing power (if required) in a —> “Control unit”.
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externer Geber External encoder none

Position encoder that is not built in or mounted on the —> “Motor”, but is attached
via a mechanical transmission element or mechanical intermediate element.

The external encoder (see —> “Externally-mounted encoder”) is used for —> “Direct
position detection”.

Geber Encoder none

An encoder is a measuring system that captures actual values for the speed
and/or angular/position values and makes them available for electronic processing.
Depending on the mechanical construction, encoders can be integrated in the

—> “Motor” (—> “Motor encoder”) or mounted on the external mechanics (— “Exter-
nal encoder”). Depending on the type of movement, a distinction is made between
rotary encoders (also known as “rotary transducers”) and translatory encoders

(e. g. —> “Linear encoders”). In terms of measured value provision, a distinction is
made between —> “Absolute Encoder’s (code sensors) and —> “Incremental En-

coder’s.
See —> “Incremental Encoder TTL/HTL” —> “Incremental Encoder sin/cos 1 Vpp”
—> “Resolver”

Line Module Line Module none

A Line Module is a power components that generates the DC link voltage for one
or more —> “Motor Module’s.

In SINAMICS, there are three types of Line Module:

—> “Basic Line Module”, —> “Smart Line Module”, and —> “Active Line Module”.
The overall function of an infeed, including the required additional components (
—> “Line Reactor”, proportional computing power in a —> “Control Unit”, switching
devices, and so on) is called —> “Basic Infeed”, —> “Smart Infeed”, and — “Active
Infeed”.

Motor Motor none

For the electric motors that can be driven by — SINAMICS, a basic distinction is
made between rotary and linear motors with regard to their direction of motion, and
between synchronous and induction motors with regard to their electromagnetic
operating principle. For SINAMICS, the motors are connected to a —> “Motor
Module”.

See —> “Synchronous Motor” —> “Induction Motor” —> “Built-In Motor” —> “Motor
Encoder” —> “External Encoder” —> “Third-Party Motor”.

Motor Module Motor Module none

A Motor Module is a power unit (DC-AC inverter) that provides the power supply
for the connected motor(s).

Power is supplied through the — “DC Link” of the — “Drive Unit”.

A Motor Module must be connected to a —> “Control Unit” via — “DRIVE-CLIQ”.
The open-loop and closed-loop control functions for the Motor Module are stored in
the Control Unit.

—> “Single Motor Module’s and —> “Double Motor Module”s are available.
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Motorgeber Motor Encoder none

An —> “Encoder” (e. g. — “Resolver”, —> “Incremental Encoder TTL/HTL”, or

—> “Incremental Encoder sin/cos 1 Vpp”) that is integrated in or attached to the
motor.

The encoder detects the motor speed. In the case of synchronous motors, it can
also detect the rotor position angle (of the commutation angle for the motor cur-
rents).

For drives without an additional — “Direct Position Measuring System”, it is also
used as a —> “Position Encoder” for position control.

In addition to the motor encoders, —> “External Encoders” for —> “Direct Position
Sensing” are available.

Option Board Option Board
PC board inserted in the —> “Control unit” (e. g. a —> “Terminal board” 30, TB30).

Option Siot Option Siot none

Slot for an optional module (e.g. in the —Control Unit).

Parameter Parameter none

Variable quantity within the drive system that the user can read and, in some
cases, write. For —> “SINAMICS?”, all specifications defined in the —> “PROFIdrive”
profile are defined by a parameter.

See —> “Visualization Parameter” —> “Adjustable Parameter”.

PROFIBUS PROFIBUS none

Field bus to IEC 61158, Sections 2 to 6.

The abbreviation “DP” is no longer included because PROFIBUS FMS is not stan-
dardized and PROFIBUS PA (for Process Automation) is now part of the “general”
—> PROFIBUS.

Sensor Module Sensor Module SMCxx
SMEXxx

Hardware module for evaluating speed/position encoder signals and providing de-
tected actual values as numerical values at a —> “DRIVE-CLiQ Socket”.

Three mechanical Sensor Module variants are available:

— SMCxx = Sensor Module Cabinet-Mounted

— SME = Sensor Module Externally Mounted (with a high degree of protection)
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Servoantrieb Servo Drive none

An electric servo drive comprises a motor, a —> “Motor Module”, and a — “Servo
Control” and, in most cases, a speed and position —> “Encoder

Electric servo drives are normally extremely precise with a high dynamic response.
They are designed for cycle times to less than 100 ms, and often have a short-time
overload capacity, which enables quick acceleration. Servo drives are available as
rotary and linear drives. and are used for machine tools, handling robots, and
packaging machines.

Servoregelung Servo Control none

For — “Motor”s equipped with a —> “Motor Encoder”, this control type allows
operation with a high level of —> “Accuracy” and —> “Dynamic Response”.
In addition to speed control, position control can also be implemented.

SITOP power SITOP Power none

—> “Electronics Power Supply” component.
Example: 24 V DC

Smart Line Module Smart Line Module none

Unregulated line infeed/feedback unit with a diode bridge for the infeed and
stall-protected, line-commutated feedback via —> “IGBT”s.
The Smart Line Module supplies the DC link voltage for the —> “Motor Module”s.

STARTER STARTER none

STARTER is used to commission and parameterize drive units. This tool can also
be used to execute the diagnostic functions required during servicing (e.g.
PROFIBUS diagnostics, function generator, trace). See —> “SIZER” —>
“Engineering System”.

Steuerwort Control Word STW

Bit-coded — “Process data” word. —> “PROFIdrive” transmits this word at cyclic
intervals to control the drive states.

Terminal Board Terminal Board TBxx

A terminal expansion board that is inserted in the —> “Control Unit”.
In —> “SINAMICS”, the Terminal Board 30 (TB30) with analog and digital I/O termi-
nals is available, for example.
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Terminal Module Terminal Module TMxx

Terminal expansion board for snapping onto the installation rail, for installation in
the control cabinet.

In —> “SINAMICS?”, the following Terminal Modules are available, for example:

— TM3x = Terminal Modules with digital and analog I/O terminals

— TM4x = Terminal Modules with encoder emulation

Vektorregelung Vector Control

Vector control (field-oriented control) is a high-performance control type for induc-
tion machines. It is based on an exact model calculation of the motor and two cur-
rent components that simulate and accurately control the flux and torque by means
of software algorithms, thereby enabling predefined speeds and torques to be ob-
served and limited accurately and with a good dynamic response.

Two vector control types exist:

Frequency control (— “Sensorless Vector Control”) and speed-torque control with
speed feedback (—> “Encoder”).

Zustandswort Status Word ZSW

Bit-coded —> “Process Data” word. —> “PROFIdrive” transmits this word at cyclic
intervals to control the drive states.
The abbreviation “ZSW” must be used in all languages!
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